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WinADCP User's Guide

RD Instruments

Acoustic Doppler Solutions

WInADCP User's Guide

1 Introduction

This guide is an overview on using the WinADCP software provided with your

system.

@ NOTE. This guide covers version 1.11 or earlier.

1.1 System Requirements
WinADCP requires the following:

Windows 95®, Windows 98®, or Windows NT 4.0® with Service
Pack 4 installed

NOTE. Install all critical software updates from Microsoft before installing
WinADCP.

Pentium class PC 233 MHz (350 MHz or higher recommended)
32 megabytes of RAM (64 MB RAM recommended)

6 MB Free Disk Space plus space for data files (A large, fast hard
disk is recommended)

Minimum display resolution of 800 x 600, 256 color (1024 x 768
recommended)

CD-ROM Drive

Mouse or other pointing device
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1.2

2.1

2.2

Software Installation

To install the software, do the following.

a. Insert the compact disc into your CD-ROM drive and then follow the
browser instructions on your screen. If the browser does not appear, com-
plete Steps “b” through “d.”

b. Click the Start button, and then click Run.

c. Type <drive>:launch. For example, if your CD-ROM drive is drive D, type
d:launch.

d. Follow the browser instructions on your screen.

Once, installed, you will have a shortcut added to your Windows® Start menu.
The Winadcp shortcut will start WinADCP.

@ NOTE. The default directory for WinADCP installation is C:\program
files\RD Instruments\Winadcp.

Using WIinADCP

WinADCP is a software package for use with RDI Acoustic Doppler Current
Profilers. This software package supports both the Narrowband and the Broad-
band/Workhorse Binary Output Data Formats.

In general, WinADCP gives the user a visual sense of the entire set of data. It
also allows the user to zoom in on a portion of the data for closer analysis.

Opening Data Files

You can open BroadBand, NarrowBand, or WorkHorse raw binary data files.
Binary data files that have segmented consecutive file names (i.e.
DEMO001r.000, DEMOO001r.001, DEMOO001r.002) will be read in as one file if
MultiFile is enabled on the File menu.

a. On the File menu, check that MultiFile is checked. Click Open.
b. Select the data file to be opened.
c. Click Open.

Whole Set

WinADCP has two main graphic display forms. The form located in the upper
right portion of the screen is called the Whole Set. The form located across the
bottom half of the display is called the Sub Set. Each of these forms displays a
portion of the entire data set as a color contour. In addition to the color contour,
Sub Set displays the user selected Profile, Series, and Ancillary data.

page 2
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2.3

The Whole Set form is displayed in the upper right-hand portion of WinADCP.
When a file containing a Binary Output Data Format is opened, the entire set of
the selected data type is displayed as a color contour located within the Whole
Set form.
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Figure 1. Whole Set
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Figure 2. Sub Set

Selected Set

By holding down the Spacebar and then pressing the Left mouse button, the
user can drag the mouse to select a portion of the entire data set. When the
mouse button is released, the selected portion of the Whole Set is marked by a
blinking box outline. The blinking box outlines a set of data called the Selected
Set. A second blinking box is also created when the mouse is released. This
second box is striped or solid depending on your graphics card. The solid blink-
ing box marks a region of data called the Sub Set. The width of the Sub Set
box may not be as wide as the Selected Set box. The width of the Sub Set is
dependent upon the Options, Ensembles setting selected from the main menu.
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24

Figure 1, page 3 shows an example of the Whole Set contour display. The Sub
Set contour display is identical except it does not show the Selected and Sub
Set ensemble numbers (located in the upper right corner of the chart).
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Figure 3. Selected Set

Profile Chart

The Profile chart, located on the left side of the Sub Set form, displays a user
selected ensemble in several two dimensional (2D) charts. Each of these “sub
charts” contains a different data type taken from the ensemble. The user can
select the profile ensemble by double clicking the left mouse button just above
or just below the Sub Set color contour.

NOTE. Use the left and right keyboard arrows to scroll through the
ensembles. Use the Animate menu to automatically scroll through the
data file. To quickly select an ensemble, double-click a point just above or
below the Sub Set color contour plot.

Profile

Magnitude Direction

mm/s degrees
Figure 4. Profile Chart
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2.5 Series Chart

The Series and Ancillary chart, located in the lower left-hand portion of Sub
Set, displays user selected bins of user selected data types. In addition, the user
may select any of the ancillary data types for display in this chart.

The candle chart shows the statistical information about the series chart. Use
the Options, Chart Options menu to select the Averaging Interval. The can-
dle chart will be centered on the averaging interval.

e The red line is the mean
e The middle rectangle shape is the Standard Deviation

e The long line shows the minimum and maximum values

NOTE. Double-click the candle chart to display the Series Trend and
Residuals chart.

&

NOTE. Use the up and down keyboard arrows to scroll through the bins.
Use the Animate menu to automatically scroll through the data file. To

@ quickly select multiple bins, double-click a point just to the left or right of
the color contour plot on the Sub Set color contour plot. Double clicking
the same point will unselect the bin.

Figure 5. Series and Ancillary Chart
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Figure 6. Series Trend and Residuals Chart

P/N 957-6158-00 (November 2001) page 5



WinADCP User's Guide

2.6

Track Vector Time Series

The Track Vector Time Series window displays two current vectors: one along
a selected track and the other orthogonal to it (90 degrees). The user can select
three different tracks: Navigation, Bottom, and Projected. Navigation and
Bottom use actual data contained within the ADCP ensemble. The Projected
angle is input by the user.

An application where this display is useful is in cable laying. Ocean currents
across the path of a ship tend to pull a cable off to the side. Information about
current magnitude and direction relative to the ship track helps to guide the ship
for better cable placement.

= WINADCP Track ¥ector Time Series

Exit Animate Projection Beference Display

Speed Direction Ensemble: 68
knots degrees Date: 99/04/14
Time: 09:45:59.28
EBottom 4.030 213.350
Navrigation 0.00o0 0.00

Reference EOTTOM

NAVIGATION Long Track +0.00*
T

1.94 knots p----- e YT CTTTTTTTTs i -177.05 w
0.00 knots ----- - e o e r—‘\f““*-:".l-\;av"-' i e "T”-":"":"-_;J:
-1.94 knots [----- lmmmm e ettt bommmmmmmm o 1
E min 4 min Z min 0 min
NAVIGATION Cross Track +90.00*
1.94 knots p----- Tt VTTToTTT e ST -177.05 m
0.00 knots p----- R e L o e o g e Ay )
-1.94 knots [----- e L e

Figure 7. Track Vector Time Series
The Track Vector Time Series window has its’ own menu.

Exit — Exits the Track Vector Time Series window. To display the window
again, click Window, Track Vector.

Animate — Choose Go to animate the chart. Stop will stop the animation and
Rewind will rewind the chart to the beginning of the file.

Projection — Choose between Bottom Track, Navigation Track, or Manual. If
you select Manual, you can select your own projection angle.

page 6
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2.7

2.71

Reference — Clicking Reference will display the Chart Options menu,
Processing tab. Choose a reference from the list.

Display — Clicking Display will let you choose the Units, and Font for the dis-
play. Selecting Time Origin on Left will toggle the time origin being displayed
on the right, to the left side of the display.

Clicking anywhere on the Track Vector Time Series display will display the
Chart Options menu, Series tab. Choose the bins to display by selecting the
bin box on the list.

NOTE. The Animation and Reference menus are disabled on the Track
Vector window when the Monitor mode is enabled. All other menus are

(% available.
Negative range numbers are shown when the system is downward facing
(bins are below transducer). If the system is upward facing the range
numbers are positive.

Saving Files
The Selected and Sub Set plots may be saved to new data files as needed.

Save a Sub Set File

On the Whole Set color contour plot, use the Zoom feature (see “Selected Set,
page 3) to select the portion of the Whole Set to be displayed in the Sub Set
color contour plot. You can use the zoom feature on the Sub Set color contour
plot to further zoom in on the data.

2

a. On the File menu, click Save Sub Set.

b. Give the file a unique name. WinADCP does not add an extension type to
the file. To organize data files, you may want to add the *.000 file exten-
sion.

c. Click Save.

A CAUTION. If the file name already exists as a closed data file, then the file
will be written over. You will be prompted if it is OK to overwrite the file.

NOTE. If the file name you select is the same as the currently open file
then the Sub Set of data is not written to the file.

The Sub Set has a limit of 8,192 ensembles.

If the Binary Data File that was opened had segmented consecutive file

6 names (i.e. DEMOO001r.000, DEMOO001r.001, DEMOO001r.002) when you
save the Sub Set, it will be saved as one file. Make sure you use a unique
name to avoid overwriting a data file.

The format of the Sub Set file is the same as the raw ADCP Binary Data
File format. Sub Set files may be opened with other RDI Software.
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2.7.2

2.8

Save the Selected Set

On the Whole Set color contour plot, use the Zoom feature to select the Se-
lected Set.

On the File menu, click Save Selected Set.

b. Give the file a unique name. WinADCP does not add an extension type to
the file. To organize data files, you may want to add the *.000 file exten-

sion.

c. Click Save.

A

CAUTION. If the file name already exists as a closed data file, then the file
will be written over. You will be prompted if it is OK to overwrite the file.

L

NOTE. If the file name you select is the same as the currently open file
then the Sub Set of data is not written to the file.

The Selected Set does not have a limit on the number of ensembles.

If the Binary Data File that was opened had segmented consecutive file

names (i.e. DEMOO001r.000, DEMOO001r.001, DEMOO001r.002) when you
save the Selected Set, it will be saved as one file. Make sure you use a
unique name to avoid overwriting a data file.

The format of the Selected Set file is the same as the raw ADCP Binary
Data File format. Selected Set files may be opened with other RDI
Software.

Printing Charts

Charts may be copied to the Windows® clipboard so that they may be pasted or

printed in other programs.

a. On the Edit menu, click Copy.
b. Select either the Whole Set or the Sub Set.
The chart will be placed on the Windows clipboard.

d. Open the graphic program (or Word) and select Edit, Paste.

e. Use the graphic program (or Word) to print the chart.

£

NOTE. If you use the Edit, MSPAINT menu the Whole Set or Sub Set will
be placed as a Bit Map image on the Windows clipboard and will open the
Microsoft Paint program. In Paint, select Edit, Paste to display the Bit
Map.

The shortcut to the Microsoft Paint program expects the program to be in
the default directory C:\Windows.
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2.9  Flip

Selecting Flip from the Edit menu causes the file to be re-read with the orienta-
tion bit inverted. In other words, an upward facing data set appears as a down-
ward set when Flip is clicked.

2.10 Data Viewer

When the Mouse is positioned over a point within the Sub Set color contour
charts, data associated with the bin and ensemble are shown on the Viewer
form. If the Viewer is not visible, select the Window menu and click on
Viewer. A sample of the Viewer is shown below.

7 WINADCP Viewer =]

Fart

rnsemhle TEls Date 37706706 ;I
Ein 2 Time 11:32:00.00
Batige (m) la.00

Array BE1l/E EZ/N B3/V Edlfe Av/Mg Dir

WV ommiSs —45E 2L jc3 Z 47z zgl.&"
E cnt 1E0 147 145 154 149

C cnt 1403 11& 121 11Z 114

Pitch -Z_.99"°

Boll -2.33"

Heading lg3_ 68"

Temperature ZE.39°
Depth Sensor 15.00 meters

EIT u]
4 A
Figure 8. Data Viewer

Most items are self-explanatory, however the ARRAY data in the center requires
explanation. There are three rows of data:

a. The top row contains Velocity data (V). The first value is -462; this is the
Eastward velocity component in millimeters per second. The 95 is the
Northward followed by the Vertical, error, Magnitude, and Direction of the
velocity.

b. The middle row contains Echo Intensity data in counts. The 150 is Beam 1°’s
Echo Intensity followed by Beams 2, 3, and 4. The last value (149) is the
average of the four Echo Intensity values.

c. The last row contains Correlation data if the ADCP is a Broadband or
WorkHorse otherwise Spectral width for the Narrowband ADCP. If the data
are not available then zeros are displayed.
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= WINADCP Viewer M=l E3
Fant
Ensemhle 40 Date 01710710 -:J
Ein 3 Time 15:48:01.34
Range (m) -11.11
Array El/E EZ/N B3IV EBEd4/e baw/Mg Dir
V mmSs-3F768-3F768-32768-32768-32768-32765"
E cnt 41 43 29 cic] 40
C eont 1& 17 10 7 1z
IGood u} u] 1an0 u]
E mm/= u} u] u] u] u} o.o"
W mm/= u} u] u] u] u} o.o"
N mm/= u} u] u] u] u} o.o"
D (cm) u] u] u] a a
Pitch -0.08"°
Roll -0.36"°
Headirng 105.74°
Tenperature z4_0z°
Depth Sensor 0.00 meters
EIT u]

First Last TWinRiver
LAT o.o0" o.oo* o.oo®
LON o.o0" o.oo* o.oo®
MicroCAT String:
0l, 00000, &5.8367, 3.44771, 367.068, 35.1089, 01 Jan 1920, 09:17:11

o
< A
Figure 9. Data Viewer with MicroCAT Data

03

NOTE. Lat/Lon and MicroCAT data will not be visible unless the data was
collected.
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2.11 File Details

On the Utilities menu, click File Details. Sclect the data file to be examined.
The file utility window will show you everything there is to know about the file

contents.
. WINADCP File Details M=l
— Enzemble Statiztics
First Last tizzing Repeats Rezets Wwrong Size
L [z15 o [o [o [o
Bin Size (U8} 3.00 m N

Head Aliogn {EA) 0.00 degrees

Hzad Eias LEE) 0.00 degreess

Coord ¥form (EX) 11111 Earth Coordinates Using Tilts, 3 Beam Solutiorn
Bens Source (EE) 1111111 cdhprst

Sens Avail 0011101 cdhprst

Time/Ping (TP) 00:01.00

Hardware 4 Beams

Lag 28 elements
Code Beps. 12

Lag Length 0.Z5 m

Fmt Length .37 m

1=t Bin Ellm

ET Pings/Ens (BEF) 1

ET Ens Delay (EL') 0O

ET Cor.Thres. (BC) Zz0 counts
ET Ewal. Thres. (BA) 30 counts
ET P> Thres. (BZ) 0O

ET Mode (EM) &

ET Err Thres. (BE) 100 mm/=
ET Max Range (BX¥) 1700 dm

First Ensewble 00000001 0O0,11/11 14:43:04.93
Last Ensewble 00000Z15 00,11511 14:E50:1z.99
Extra Data in File 0 bytes

NWEAM Data Set FALSE

< |

St

i

Figure 10. File Details
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3 Chart Options

The Options menu controls how the displays are shown. Selecting Chart Op-
tions under the Options Menu brings up the Chart Options dialog box. There
are five tabs on the dialog box:

e Contour Tab

e Profile Tab

e Series Tab

e Ancillary Tab

e Processing Tab
Six buttons are positioned along the bottom of the Chart Options dialog box.
Default - restores each of the four options pages to factory selected ones.
Load - reads in, from a selected file, a previously saved set of option pages.
Save - writes out, to a named file, the contents of the option pages.
OK - updates the screen to the new setting(s) and close the options dialog.
Cancel - close the options dialog.

Apply - update the screen to the new setting(s) but does not close the options
dialog.

maximum number of ensembles shown in both the Sub Set Color

:§ NOTE. Max Ensembles, under the Options menu, is used to set the
Contour and Series charts.
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3.1 Contour Tab

The Contour tab has five control groups for controlling the Whole Set, Sub Set
and color contour charts.

w WINADCP Chart Options

| Frofile I Sernes I Ancillary I Froceszing I

Appearance
kit [ ¥ Locators
¢ Manual [-1000 |1|:||:||:| ¥ Grid
" Peak [~ BT Depth
1 std
 Zstd
f* 3std
— Data Type
Welocity Carrelatian .E.:':nﬁtude Eeﬂ:;:; it

" East[u] " Beam1  Beam1 ( PGI1
" Narthv] " Beam? ( BeamZ ( PGZ2
" Verical [w] ¢ Beam3 " Beam3 " PG3

" Emrar " Beamd4 " Beamd { PG4
* Magnitude { Awverage & Awverage
" Direction
— Selected Set Sub Set
Enzemble Bin Enzemble
Firzt {4 First |4 1
Last [ga Last |50 [
Defaultl Load | Save | ] | Eancell Appl

Figure 11. Contour Tab

Scale - Five choices for selecting the maximum and minimum values of the
color scale.

e Manual - user entry of values.

e Peak - Automatic setting to the max/min values contained in the data
set.

e 1 std - Automatic setting to data mean plus and minus ONE standard
deviation.

e 2 std - same as above but TWO standard deviations.
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e 3 std - same as above but THREE standard deviations.
Appearance - Three check boxes.

e Locators - turn on/off the blinking boxes of the Whole Set color con-

tour.

e Grid - turn on/off the grid that overlays both color contour charts.

BT Depth — When checked and Bottom Track depth data is available,
a bottom contour line is drawn on top of the color contour plot. If
beam 1 through 4 RSSI or correlation is selected for display, the

beams depth is shown. Any other selection will show the contour
line as the average of the four beams.

Data Type - Used to select one of the data types for display.
Selected Set - Used to select the first and last ensembles of the Selected Set.
Sub Set - Used to select the first and last ensembles of the Sub Set.
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3.2 Profile Tab

The Profile tab has four control groups for controlling the Profile chart.

# WINADCF Chart Dptions |

Contaur | F I Series I Apncillary I Frocessing I
—Scale — Appearance —
Mir M an ¥ Lines

Echa Intensity |54 192 Counts [~ Symbols
Correlation B4 192 Counts v Grid
Welocity Aooo [ooo s
Magrituide 500 2000 s — Engemble ——
Direction a0 =70 Deq |-|—
Statistics 00 100 s
PGood i 100 x

—Data Type
Welocity Carrelatian Echa Percent

[~ Eastu) [ Beam1 Amplitude Good
[ Morhlv] [~ Beam2 [~ Beam1 [ PG1
[~ Werical[w) [~ Beam3 [~ Beam2 [~ PG2

[~ Emar [T Beamd4 [ Beam3 [ PG32
¥ Magnitude [~ Awverage [ Beamd [ PG4
v Direction [~ Awerage

Statistics

[~ Awerage Error
[T Standard Deviation
[T Percent Good

Defaultl Load | Savel ] | Eancell ¥ 1]

Figure 12. Profile Tab

Scale - Manual selection of the maximum and minimum values for each data
type.
Appearance - Three check boxes.

e Lines - Turn on/off the connection of lines between data points.

e Symbols - Turn on/off a symbol at each data point location.

e Grid - Turn on/off the grids that overlay the profile charts.
Ensemble - Used to select the current ensemble.

Data Type - Used to select several of the data types for display.
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3.3

Series Tab

The Series tab has five control groups for controlling the Series chart.

# WINADCF Chart Dptions |

—Scale —Appearance ——
Min  Max v Combo
Echa Intensity |54 192 Counts ¥ Lines
Correlation B4 192 Counts [~ Symbols
Welocity Aooo [ooo s v Grid
Magrituide 500 2000 s
Direction a0 o270 Deq — Binz
|
—Data Type ]2 =
: , Echa  Percent 13
Yelocity  Carrelation Intensity Good 4

[~ Eastiu] [~ Bml [~ Bml [ PGI L13
[~ Mothlv] [~ Bm2 [~ Bm2 [ PG2 L6
™ Vettical (w]~ Bm2 [~ Bm2 [~ PG2 L7
 Ewor | Bmd [ Bmd [ PG4 | |[Z°®

W Magnitude [~ Avg [ Avg E'IEIEI

v Direction 111

Statistics e

Averaging Interval 113

114

= Al DO00:0&5: 5291 115
 User ||:u:|12:|:u:|:|:u:|_|:u:| 116 -

Drefault | Load | Save | ] | Cancel | ¥ 1]

Figure 13. Series Tab

Scale - Manual selection of the maximum and minimum values for each data
type.
Appearance - Four check boxes.

e Combo - When selected each bin of a data type is plotted on the same
chart.

e Lines - Turn on/off the connection of lines between data points.
e Symbols - Turn on/off a symbol at each data point location.
e Grid - Turn on/off the grids that overlay the series charts.

Data Type - Selects several of the data type for display.

page 16

RD Instruments



WinADCP User's Guide

Statistics - Selects the time interval over which statistics are calculated.
e All - The total time of the Sub Set data.

e User - Used when several statistic sets over the Sub Set interval are
desired.

Bins - Selects which bin to display.

3.4 Ancillary Tab
The Ancillary tab has three control groups for controlling the Ancillary chart.
= WINADCP Chart Options ]|
| Froceszing I
—Scale Min Man .-’-'-.ppatarance
. v Lines
Pitch 20 20 Deg
[~ Symbolz

Roll 20 20 Deg 7 Grid
Heading a0 270 Deg o
Temperature | 20 Deg
Depth 100 300 Meters
Orientation [ 1 Counts
BIT 0 1 Counts
B attery Fd 192 Counts
Velocities (o000 [ooo T
Magnitude  |500 2000 T
Direction a0 270 Deg
Wiater Density |1 000,00 K.gdm™3

—Data Type
[~ Pitch — Battarn Track 7w ater Mass—— Mavigation—;
[~ Rall [~ East[u) [~ East[u) [~ East[u)
[~ Heading [~ Math[v] | [T Moth(v] | [ Morth[v]
[~ Temperature| [~ et )] [~ “ert [w) [~ Mag
[~ Depth [~ Emrar [~ Emrar [ D
[~ Orentation | [~ Mag [~ Mag
[~ BIT [~ | Dir [~ | Dir
[~ Batterny

Drefault | Load | Save | ] | Cancel | Appl

Figure 14. Ancillary Tab

Scale - Manual selection of the maximum and minimum values for each data
type.
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Appearance - Three check boxes.
e Lines - Turn on/off the connection of lines between data points.
e Symbols - Turn on/off a symbol at each data point location.
e Grid - Turn on/off the grids that overlay the ancillary charts.
Data Type - Selects several of the data type for display.

6 NOTE. Water density is used to convert pressure to depth, if the pressure
data is available.

3.5 Processing Tab

The Processing tab allows the selection of a velocity reference; None, Bottom
Track, or Navigation.

NOTE. The Navigation (VmDas) is VmDas format only, don’t use this for
WinRiver. GPS (GGA) and GPS (VTG) are in WinRiver format.

w WINADCP Chart Dptions

Eontourl Profilel Series I Ancillary P

Welocity Reference————————— Welocity Scale————
&+ None Wwhater [1.000

" Bottam Track, Battom [1 nno

= Navigation [VMDA&5)

 GPSIGGA]
© GPSVTG]
 water Mass [BK <»1]

Defaultl Loadl Savel [0k | Eancell Appl_l,ll

Figure 15. Processing Tab
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4 Exporting Data

Clicking the main menu item Export brings up the WinADCP Export Options
dialog box. There are three styles of export: Contour, Profile, and Se-
ries/Ancillary.

The MAT file output has a MatLab compatible binary format. From MatLab
type load filename.mat then type who. The Column = Bin and Row = Ensemble. A
list of variables for each output format is shown.

4.1 Contour

Exporting contour data allows the selection of one data type (Velocity, Magni-
tude, Amplitude, Correlation, and Percent Good), the first/last ensembles, the
first/last bins, and the file format.

o WINADCP Export Options

— File Type —Data Type
= TH=T . : Echa Percent
YW eloity Carrelation Amplitude  Good
¥ " East [u) Bl Bml PRI
B = Marth[v] & Bm2  Bm2 & PG2
: " Mettical ] © Bm3 Bm3 O PR3
Firzt
st i  Enor  Bmd  Bmd O PG4
Last|5|:| = Magnitude  Awvg  Awg
StEF'I‘I— " Direction
— Enzemble
First |1
Lastlgg—
Step|1

| Wirite File | (it Expaort |

Figure 16. Export Data — Contour
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The Contour export variables are: (Con refers to Contour)

ConBins RDIBinSize
ConEnsembles RDIEnsDate
ConTitle RDIEnsInterval
ConVel RDIEnsTime
RDIBinlMid RDIFileName

For the Profile export the variables are:

ProCorlcnts ProEAmpBmAvgcnts
ProCor2cnts ProEmmpersec
ProCor3cnts ProErmmpersec
ProCor4cnts ProMagmmsec
ProCorAvgcnts ProNmmpersec
ProDirlOthDeg ProVmmpersec
ProEAmpBmlcnts RDIBinlMid
ProEAmpBm2cnts RDIBinSize
ProEAmpBm3cnts RDIEnsDate
ProEAmpBm4cnts RDIEnsInterval

RDIPingsPerEns
RDISecPerPing
RDISystem

(Pro refers to Profile)

RDIEnsTime
RDIFileName
RDIPingsPerEns
RDIProfileBins
RDIProfileEns
RDISecPerPing
RDISystem

An example of the "TXT" format is shown below between the dashed lines.

The row of numbers 1, 6, 11, 16 are the selected bin numbers.

The columns of numbers 1390 through 1400 are ensemble numbers.

The data set, which has 3598 in the upper left-hand corner, contains velocity
magnitude data in mm/s.

"Contour Data = Velocity Magnitude mm/s"

"C:\DATA\Sampdata.000"
"Broadband 614.4 kHz"
"Pings/Ens =" 5
"Time/Ping = 00:00.00"
"First Ensemble Date =
"First Ensemble Time
"Ensemble Interval (s

i

"lst Bin Range (m) = "
"Bin Size (m) =" 0.10
1 6
1390 3598 2619
1391 2867 2464
1392 2350 3040
1393 3156 2438
1394 3025 2520
1395 2303 2918
1396 1990 3129
1397 3006 2079
1398 2341 2027
1399 2390 1334
1400 2426 2175

95/03/21"

03:44:23.78"

=" 1.71
0.33
11 16
3099 998
2919 491
2357 805
2682 2138
2096 2305
2121 271
3232 421
947 644
1804 657
1854 616
2135 514
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4.2 Profile

Exporting Profile data allows the selection of many data types, one ensemble,
the first/last bins, and the file format.

w WINADCP Export Dptions

— File Type —Data Type
& T=T . : Echo Percent
Welocity Carrelatian Amplitude  Good
L [~ East[u) [ Bml [ Bml [ PFG&E1
i [~ Math(+] [~ Bm2 [ BmZ [ PGZ2

I— [~ “etical[w] [~ Bm3 [ Bm3 [ PG3

1 I Eror I Bmd [ Bmd [ PG4

Last |5|:| W Magnitude [~ Awva [ Awg
I'I

First

Step v Direction

— Ensemble

——

Wiite File | Cluit Export |

Figure 17. Export Data — Profile
An example of the “TXT” format is shown below between the dashed lines.
The row of numbers 1, 5, 9, 13, 17 are the selected bin numbers.

The left-hand column contains data type titles (16 possible):

“EAA” is Echo Amplitude Average (average of the four beams).

“CA” 1s Correlation Average (average of four beams).

“Mag mm/s” is the velocity Magnitude in millimeters per second.

“Dir deg” is the velocity Direction in degrees.

"Profile Data Ensemble Number = " 1341
"C:\DATA\Sampdata.000"

"Broadband 614.4 kHz"

"Pings/Ens =" 5

"Time/Ping = 00:00.00"

"First Ensemble Date = 95/03/21"
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4.3

"First Ensemble Time
"Ensemble Interval

(m)

"lst Bin Range
"Bin Size (m)

"EAA cnts"
"CA cnts"
"Mag mm/s"
"Dir deg "

03:43:02.46"

13 17
148 122
132 122
608 1344
3 92.7 80.0

Series/Anci

(s) =" 1.71
=" 0.33
0.10
1 5 9
173 169 152
138 156 100
1499 612 799
91.3 54.9 163

Exporting Series/Ancillary data allows the selection of many data types, the
first/last ensembles, the first/last bins (of the series data), and the file format.

w WINADCP Export Dptions

]|

— File Type — Series Data Types E naemble
e ITXT Welocity Carrelatian .E.:':nﬁtude Ei:;:;nt FES I1
Last
® I Easti) [ Bml [~ Bml [~ PG S EE
Bins [~ Math(+] [~ Bm2 [ BmZ [ PGZ2 5tBD|1
E_z I_ Yertical ['."'.'] I_ B3 I_ B3 I_ Pla3
2 — [~ Emrar [ Bm4 [ Bmd [ PG4
BE v Magnitude [~ Awg [ Awvg
4 v Direction
[]5 _
16 fne [_:'E'ta Types Bottomn Track 4 'water Mass— [ ‘winRiver
[~ PFitch M awiabio
7  Rol [~ East[u) [~ East[u) M avigation
L ™ Headn [ Math[w] | [T Moth(v] | [ East[u)
mE - Ton Eiture I Vet(w] | [ Verlw) | [ Morh(v]
[]10 - Depti [~ Emrar [~ Emrar [~ Mag
Om = O . [~ Mag [~ Mag [ D
12 rnentation . .
([l [ Dir [ Dir [~ Lat/Lan
113 - [ BIT
[~ Battery [~ MicraCAT
| Wiite File | Cluit Export |
Figure 18. Export Data — Series/Ancillary

NOTE. If you are exporting navigation data form a data file collected with
WinRiver, make sure to check the WinRiver box. This lets WinADCP
know where to look for the navigation data.
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"Series Data"

An example of the “TXT” format is shown below between the dashed lines.

The row of numbers 1, 7, 13, 19 are the selected bin numbers.

Ancillary data does not have a bin number above it.

The columns of numbers 1390 through 1400 are ensemble numbers.

"Series Data"
"C:\DATA\STEIN\BIGGE\TRANDATA\Bigg020r.000"
"Broadband 614.4 kHz"

"Pings/Ens =" 5

"Time/Ping = 00:00.00"

"First Ensemble Date 95/03/21"

"First Ensemble Time = 03:44:23.78"
"Ensemble Interval (s) = " 1.71

"lst Bin Range (m) = " 0.33

"Bin Size (m) =" 0.10
"Hea" "Mag" "Mag" "Mag" "Mag"
ndegn "mm/s" "mm/s" "mm/s" "mm/s"

1 7 13 19 1 7 13 19

1390 178.62 3598 3182 1289 1627
1391 177.85 2867 2958 1474 1736
1392 179.65 2350 2435 2154 1986
1393 179.30 3156 2533 1831 2156
1394 179.75 3025 2514 1463 1107
1395 178.53 2303 2475 1652 1407
1396 179.53 1990 2884 1989 2621
1397 177.95 3006 2652 1379 1396
1398 177.62 2341 2257 1127 1468
1399 177.52 2390 2069 1184 630

1400 174.92 2426 2625 2901 1655

"Dir"
ndegn

102.9
87.4

91.3

100.3
62.
83.
93.
84 .
85.
93.
85.

O 0O J O J

"Dir"
ndegn

"Dir"
ndegn

68.
57.
84 .
94 .
92.
73.
90.
79.
66.
115.2
63.3

O B®» UTowO OO J

MicroCAT export is available as TXT format only.

"C:\My Documents\TEST2"
"Broadband 614.4 kHz"
"Pings/Ens ="6
"Time/Ping

"First Ensemble Date =
"First Ensemble Time =
"Ensemble Interval (s
"lst Bin Range (m) =

(m)

"Bin Size

Ens HH MM
1 11 13
2 11 14
3 11 14
4 11 14
5 11 14
6 11 14
7 11 14
8 11 15
9 11 15
10 11 15
11 11 15
12 11 15
13 11 15
14 11 16
15 11 16
16 11 16
17 11 16
18 11 16
19 11 16

00:01.00"
01/10/10"
11:13:50.72"
) =" 10.00
"3.11
=" 2.00
SS HH "pit"n "Rol" "BIT" "MicroCAT"
ndegh ndeg wn

50 72 -0.13 -0.36 0 01, 00000, 5.8361, 3
00 72 -0.13 -0.35 0 01, 00000, 5.8365, 3
10 72 -0.14 -0.36 0 01, 00000, 5.8364, 3
20 72 -0.14 -0.36 0 01, 00000, 5.8363, 3
30 72 -0.14 -0.35 0 01, 00000, 5.8363, 3
40 72 -0.13 -0.36 0 01, 00000, 5.8363, 3
50 72 -0.13 -0.35 0 01, 00000, 5.8362, 3
00 72 -0.14 -0.36 0 01, 00000, 5.8363, 3
10 72 -0.13 -0.36 0 01, 00000, 5.8362, 3
20 72 -0.13 -0.35 0 01, 00000, 5.8362, 3
30 72 -0.13 -0.35 0 01, 00000, 5.8361, 3
40 72 -0.13 -0.35 0 01, 00000, 5.8360, 3
50 72 -0.13 -0.36 0 01, 00000, 5.8363, 3
00 72 -0.13 -0.36 0 01, 00000, 5.8363, 3
10 72 -0.13 -0.35 0 01, 00000, 5.8359, 3
20 72 -0.13 -0.36 0 01, 00000, 5.8363, 3
30 72 -0.13 -0.36 0 01, 00000, 5.8361, 3
40 72 -0.13 -0.36 0 01, 00000, 5.8363, 3
50 72 -0.13 -0.36 0 01, 00000, 5.8364, 3

.44779,
.44779,
.44779,
.44779,
.44779,
.44778,
.44778,
.44779,
.44779,
.44778,
.44779,
.44778,
.44778,
.44779,
.44779,
.44778,
.44779,
.44778,
.447717,

366

366.
366.
366.

.974,

367.000,

366.
366.

367.006,
367.000,

366.
366.
366.
366.
366.
366.
366.
366.

.1075,
.1070,
.1072,
L1072,
.1072,
L1071,
L1073,
L1073,
L1073,
L1072,
.1075,
.1074,
L1071,
L1072,
.1077,
L1071,
.1075,
.1071,
.1069,

Jan 1980, 04
Jan 1980, 04
Jan 1980, 04

Jan 1980, 04:

Jan 1980, 04

Jan 1980, 04

Jan 1980, 04

Jan 1980, 04
Jan 1980, 04

Jan 1980, 04:

Jan 1980, 04

Jan 1980, 04

Jan 1980, 04:

Jan 1980, 04:43:
Jan 1980, 04:
143:
:43:
143:
43:
144
Jan 1980, 04:44:
:44:
Jan 1980, 04:44:
Jan 1980, 04:
:44:
:45:
:45:
45:
:45:
Jan 1980, 04:45:
:45:
46:
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20 11
21 11
22 11
23 11
24 11
25 11
26 11
27 11
28 11
29 11
30 11
31 11
32 11
33 11
34 11
35 11
36 11
37 11

00 72 -0.13 -0.36 0 01, 00000, 5.8362, 3.44778
10 72 -0.13 -0.36 0 01, 00000, 5.8362, 3.44778
20 72 -0.12 -0.36 0 01, 00000 5.8361, 3.44778,
30 72 -0.13 -0.36 0 01, 00000, 5.8361, 3.44778
40 72 -0.13 -0.35 0 01, 00000, 5.8360, 3.44778
50 72 -0.12 -0.36 0 01, 00000 5.8363, 3.44778,
00 72 -0.12 -0.36 0 01, 00000, 5.8363, 3.44778
10 72 -0.12 -0.35 0 01, 00000, 5.8363, 3.44778
20 72 -0.12 -0.36 0 01, 00000 5.8363, 3.44777,
30 72 -0.12 -0.36 0 01, 00000, 5.8362, 3.44778
40 72 -0.12 -0.34 0 01, 00000, 5.8362, 3.44778
50 72 -0.11 -0.35 0 01, 00000 5.8365, 3.44778,
00 72 -0.11 -0.35 0 01, 00000 5.8365, 3.44778,
10 72 -0.11 -0.35 0 01, 00000, 5.8362, 3.44777
20 72 -0.09 -0.36 0 01, 00000 5.8361, 3.44778,
30 72 -0.11 -0.35 0 01, 00000 5.8365, 3.44778,
40 72 -0.08 -0.35 0 01, 00000, 5.8360, 3.44777
50 72 -0.11 -0.36 0 01, 00000 5.8362, 3.44778,

Monitor Mode

WinADCP has the ability to automatically update the reading of a file as real-

366.
366.
366.
366.
366.
366.
366.

366.
366.
366.
366.
366.
366.

366.
366.
366.

L1072,
L1072,
.1074,
.1074,
.1074,
.1072,
L1072,
L1072,
.1070,
L1072,
L1073,
.1070,
.1069,
L1072,
.1074,
.1070,
L1073,
L1073,

Jan
Jan
Jan
Jan
Jan
Jan
Jan
Jan
Jan
Jan
Jan
Jan
Jan
Jan
Jan
Jan
Jan
Jan

1980,
1980,
1980,
1980,
1980,
1980,
1980,
1980,
1980,
1980,
1980,
1980,
1980,
1980,
1980,
1980,
1980,
1980,

time data collection is occurring. When the file size increases, (due to real-time

data collection in another program such as VmDas) Monitor will automatically

reread the file at selected intervals and display the contents. When Monitor is
enabled and the file size is changing, all menu items except Monitor will be un-

available. You can change the interval by clicking Monitor, Interval. Enter

the monitor interval in seconds.
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